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Que es la Autoridad de Control de Documentos (DAC)? 
Control de autoridad de documento (DAC) de Fabsoft proporciona la automatización 
de procesos de negocios que permite a las organizaciones lograr una administración 
completa y control sobre sus operaciones. Hay muchos casos en que los documentos 
deben ser revisados  y autorizado por ciertos individuos o departamentos de una 
organización. Control de la autoridad de documento simplifica este proceso al 
enrutamiento inteligente y automáticamente de documentos a los destinatarios 
necesarios para su revisión o aprobación. 

 

Con el Control de la autoridad de documentos, los usuarios pueden definir reglas para 
determinar dónde deben distribuir documentos, basado en la jerarquía. Enrutamiento 
puede configurarse para que se produzca en todos los departamentos específicos, a los 
individuos con funciones similares, dentro de los grupos pequeños de trabajo, etc. 
Cada tipo de documento o documentos procesados por usuarios particulares incluso 
pueden establecer a quien debe ser entregado el documento. Por lo tanto una orden 
de compra puede enrutarse inteligentemente al departamento de Finanzas o un 
documento de varios empleados puede entregarse a su gerente de departamento en 
particular. Cuando se envían documentos, puede ocurrir de un nivel en un nivel – sin 
que se produzca el enrutamiento al siguiente nivel hasta que se recibe aprobación del 
nivel anterior (similar a un sistema de escalera), o se puede realizar simultáneamente. 

 

Beneficios de usar la Autoridad de Control de Docuementos  
 Con Control de la Autoridad de Documentos, las organizaciones pueden 

administrar fácilmente el flujo de sus operaciones del documento y 
racionalizar la distribución de procesos de negocios. 

 Procesos de documento pueden ser estrechamente supervisados, para que 
actividades no autorizadas son inmediatamente detectadas y eliminadas. 

 Documentos e enrutan confiablemente y revisados por las personas 
adecuadas. 

 Las reglas de enrutamiento se pueden asignar a usuarios específicos, tipos de 
documento, departamentos, etc. 

 Aumento de la participación y el acceso a la información mejora la 
productividad y confiabilidad 

 

Requisitos del Sistema 
 Reform 12 Enterprise o Reform 12 PDC 

 Plugin Control de la Autoridad de Documentos (DAC) 

 Conexión FSMonitorDataSource ODBC (instalada y configurada 
automáticamente en la instalación de Reform 12) 

 Internet Information Services (IIS) 5.0 o nueva version instalada 
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 Para evaluación y demostración: Windows XP, Windows 2003 Server, Windows 
Vista, Windows 7 o Windows Server 2008 (se admiten los sistemas operativos de 64 
bits) 

 Para los sistemas de producción: Windows Server 2003 o Windows Server 2008 
(sistemas operativos de 64 bits son compatibles) 

 Microsoft.NET Framework 2.0 (descargará e instalará automáticamente si no 
está ya presente en el sistema actual) 

 

Todas las descargas de software Reform necesario pueden encontrarse en 
www.fabsoft.com >> Sección de descargas. 

Requisitos del Hardware  
 Recomendación de Producción del Sistema (Estas sugerencias son sólo 

estimados. Entornos de alta carga pueden requerir varios servidores o 

hardware adicional.) 

1. Procesador Pentium 4 

2. 4 GB de RAM 

3. Espacio HDD de 100 GB (Redundancia Recomendada) 

4. Batería de Reserva (UPS) 

5. Servidor dedicado, no hay productos de software, excepto los 

programas de antivirus y de seguridad. 

 Requisitos mínimos del sistema para fines de demostración 

1. Procesador Pentium 4 

2. 2 GB de RAM 

3. Espacio HDD de 30 GB 

 

Especificaciones de hardware dependen enormemente de la carga de trabajo y el 
rendimiento que se requiere. Procesadores de gama superiores y una mayor cantidad 
de memoria aumentará la cantidad de información y datos que Reform puede procesar, 
mejorando el rendimiento general del sistema. Para equilibrio de carga y failover, 
también pueden utilizar varios servidores. (Nota: se requiere una licencia para Reform y 
cada Plug-in para cada Servidor que ejecuta el software.) Antes de obtener el servidor 
que desea utilizar para Reform, por favor revisar  los manuales de usuario de los plug-ins 
para requisitos del sistema, así como pueden requerir hardware adicional. Para sistemas 
de producción, se recomiendan también discos duros redundantes utilizando las 
características espejadas de RAID (matriz redundante de independiente discos) para 
minimizar la pérdida de datos y acelerar la recuperación del sistema en caso de una falla 
de hardware. También se sugieren respaldos de batería para mantener la disponibilidad 
del sistema y fiabilidad en caso de apagones 

 

http://www.fabsoft.com/
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Instalación 
Para instalar Control de Autoridad de Documentos, empezar por descargar y ejecutar 
al instalador DAC 

 

Nota: Si está ejecutando DAC en Windows Server 2003, consulte la sección 
Instalando/Configurando Internet Information Services (IIS) 2003 de este manual antes 
de continuar.  

Si está ejecutando DAC en Windows Server 2008, consulte la sección Configurando 
Internet Information Services (IIS) 7 de este manual antes de continuar. 

 

 
Si SQL Server Express no está instalado en su sistema, se instalará automáticamente. 
Esto normalmente toma entre 10 a 20 minutos entre descargar la aplicación e 
instalarla. Si Microsoft.NET Framework 2.0 no está ya instalado en su sistema, será 
automáticamente descargado e instalado. 

 

 
 

Siga paso a paso a través de los mensajes y acepte el acuerdo de licencia de usuario 
para completar la instalación. 

 

El directorio de instalación predeterminado para Reform 12 y sus plugins es 
C:\Program Files\Reform…\.  Si ha cambiado la ruta durante la rutina de instalación 
Reform, o si utiliza un sistema operativo de 64 bits, consulte la ruta adecuada en lugar 
del predeterminado al que hace referencia a lo largo de esta documentación.   

 

Registro y Licencia del Plugin 
Al evaluar Reform 12, los plug-ins también estarán en un modo de evaluación para ese 
período de tiempo. Una vez que Reform ha sido comprado y con licencia, se debe 
poner licencia a los plug-ins usados para continuar funcionando correctamente.    
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Consulte la sección "Reforma 12 licencias y registro" del Manual de Usuario Reform 
para más información acerca de cómo dar licencias a los Plug-ins de Reform 12.  
Después de introducir la licencia, el Reform Spooler se tendrá que reiniciar para 
actualizar las licencias. Puede encontrar más información sobre el servicio Reform 
Spooler en el Manual de usuario de Reform 12. 

Enviando su primer documento a DAC 

En este ejemplo, vamos a crear un nuevo formulario en el Reform Designer y 
caminando a través de una presentación típica y aprobación de flujo de trabajo.  Para 
configurar el flujo de trabajo DAC, estaremos usando el Workflow Designer que es un 
método mejorado visual para diseñar un flujo de trabajo.  El Workflow Designer nos 
permitirá utilizar el formulario que vamos a crear y realizar los cambios necesarios en 
el formulario y formularios posteriores a fin de cumplir con el flujo de trabajo DAC. 

 

En primer lugar, debe iniciarse el Reform Designer. Para abrirlo, ir a Start>Programs> 

Reform…>Designer. 

1. Por ejemplo, estamos creando un nuevo formulario con una plantilla existente. Ir a 
File>New>New. Seleccione la plantilla DAC y haga click en OK. 
 

 
 

2. Cuando le pregunta si desea abrir un archivo de texto/ASCII para diseñar, seleccione 
No. 
 

3. Después, ir a File>Save para guardar su formulario. Llámelo DAC.FOM. 
 
4. Usted ahora puede cerrar el Reform Designer ya tenemos nuestro formulario que 

vamos a utilizar junto con el Workflow Designer para distribuir el documento. 

* Ahora que tenemos nuesto formulario, podemos empezar a crear el flujo de trabajo 

DAC usando el Workflow Designer.  En primer lugar, debe iniciarse el Workflow 

Designer.   

5. Para abrirlo, ir a Start>Programs>Reform…> Workflow Designer. 

6. Una vez abierto, debemos ir a File > New… 
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7. Seleccionar “Document Automation” y haga click en Ok. 

 
 

8. Ahora verá que sus entradas, procesos y salidas han sido pobladas por varios plug-

ins que han sido instalados (DAC siendo uno de los procesos) 
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9. Podemos empezar a agregar los componentes necesarios para el flujo de trabajo. 

En primer lugar, arrastrar y soltar un objeto Form and File en el flujo de trabajo 

haciendo click y sosteniendo el mouse en Form and File, a continuación, mover el 

mouse sobre el flujo de trabajo y soltar el botón del mouse.  

 

 

 

* Aparecerá el siguiente cuadro de diálogo: 
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10. Escriba una descripción para el objeto que acaba de agregar. Para ello, escriba en el 

cuadro proporcionado. Escriba “DAC Demo” y haga click en Finish. Esto le llevará de 

regreso a su flujo de trabajo. 

11. Ahora estamos listos para configurar el formulario de “DAC” y el archivo de 
entrada.  Para ello, haga click derecho en el objeto recién agregado y seleccione  
“Configuration…” o simplemente haga doble click en el. 

 

 
 

12. Ahora aparecerá la ventana Configuración de entrada.  En primer lugar, queremos 
que seleccione la secuencia de datos o archivo de texto que va a utilizar nuestro 
formulario.  Para ello, simplemente puede empezar a escribir en el cuadro o puede 
navegar hasta encontrarlo.  Queremos que seleccione el archivo DAC.out. Haga 
click en el icono de carpeta pequeña para abrir una ventana que nos permite 
escoger ese archivo.  Seleccione el archivo y haga click en Open.   
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13. Después de seleccionar el archivo de texto, volverá a la página de configuración de 
entrada para que ahora puede seleccionar un formulario.  Haga click en el icono de 
carpeta pequeña para abrir una ventana que nos permite escoger el archivo 
deseado, el formulario DAC.FOM. Seleccione el archivo FOM y haga click en Open.  

 

 
 

14. Ahora que tiene el archivo de texto de entrada y la reforma de formulario 
seleccionado, la instalación de “Form and File” está completa.  Puede comprobar 
rápidamente que los archivos correctos fueron seleccionados y, a continuación, 
haga click en Finish.  
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15. También se pedirá que agregar un campo de salto de página a los formularios. En 

este punto, queremos seleccionar No. 

 

16. Después, queremos agregar un proceso DAC a nuestro flujo de trabajo.  Usamos el 
mismo proceso arrastrar y colocar como con el “Form and File” (ver paso 9).  
Tomar el mouse y arrastre el objeto “DAC” bajo proceso de flujo de trabajo en 
algún lugar debajo de la entrada. Una vez que suelte el mouse, se le pedirá que 
describa “DAC”.  Escriba “DAC” en el cuadro y haga click en Finish. 

 

 

17. Una vez que haga click en finalizar, volverá a su flujo de trabajo. DAC tendrá un 
título Rojo porque no se ha configurado aun. Para configurar DAC, primero debe 
conectar el objeto Form and File llamado “DAC Demo”.  Para ello, seleccione 
primero el botón “Add Connector” de la barra de menús. A continuación, arrastre 
el mouse de la pequeña “x” debajo de “DAC Demo” hacia la pequeña “x” encima 
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de “DAC”como muestra la imagen a continuación. Cuando se completa la conexión, 
el conector se volverá negro (si es roja, la conexión no se ha realizado 
correctamente, inténtelo de nuevo) y el título de “DAC Demo” cambiará a verde. 

 

18. Deberá configurar DAC al finalizar la conexión.  Haga click en Yes.   Si hace click en 
No, también puede hacer doble click en el objeto DAC o click derecho y seleccionar 
“Configuration…” para continuar la configuración en otro momento.  Aparecerá la 
siguiente ventana pidiendo el tipo de documento.  Escriba  CCStatement en el 
campo proporcionado y haga click en Next. 

 

 
 

19. Escriba Demo como el “Submitter’s UserName”. Haga click en Next. 
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20. Para la descripción, nos gustaría elegir datos variables de la secuencia de datos. 
Para ello, primero debemos pulsa el botón “Click here to select variable 
information”. 

 

 
 

*Nota-Después de hacerlo, vemos que aparece una lista con los diferentes campos que 
puede elegir para los datos variables. Vamos a seleccionar de esta lista, pero si 
necesita escribir datos estáticos, puede hacerlo haciendo click en el botón 
correspondiente para obtener información estática y escribiendo en el. 
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21. Seleccione el objeto dinámico StatementNum como la "descripción" para mostrar 
en DAC. Tendrá que desplazarse hacia abajo para verlo. Después de seleccionarlo, 
haga click en Finish. 

 

 
 

22. Ha completado la configuración del proceso de DAC.  Ahora configuramos el 
resultado del proceso de DAC que es donde irá el documento una vez aprobado. 
Queremos enviar nuestro documento aprobado en una impresora disponible. En 
primer lugar debemos arrastrar un objeto Printer en el flujo de trabajo debajo de 
DAC. Después de arrastrar la impresora, se le pedirá que describa el objeto.  
Escriba “Printer 1” en la descripción y haga click en Finish.  

 

 
 

23. A continuación hay que hacer una conexión de DAC a la  Printer 1.  Para ello, 
primero debe seleccionar el botón “Add Connector” b de la barra de menús y, a 
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continuación, arrastre el de la pequeña  “x” en DAC a la de Printer 1. Una vez que 
la conexión se complete, el conector se volverá negro y DAC cambiará a verde. 

 
24. Deberá configurar Printer 1.  Haga click en Yes.  También puede configurar 

haciendo doble click en el objeto Printer 1.  Para seleccionar una impresora, haga 
click en el botón “Printer…” para recuperar una lista de impresoras.  

 

 
 

25. Seleccione una impresora de la lista y haga click en OK.  
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26. Verifique que la impresora correcta este seleccionada y haga click en Finish. 

 

 
 

27. Usted tiene que completar la configuración del flujo de trabajo DAC.  Sus 3 objetos 
(“DAC Demo”, “DAC” y “Printer 1”) todos deben ser verde lo cual significa que se 
han configurado correctamente y está listo para crear el flujo de trabajo. 

 

 
 

28. Para hacer todos los formularios y cambios adecuados, el flujo de trabajo se debe 

ejecutar.  Para ello, haga click en el botón “Execute”  en la barra de 
menús.   Después de la ejecución, se le notificará acerca de lo sucedido. Haga click 
en OK. 
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29. El formulario aprobado ha sido creado con el nombre de CCStatement-
Approved.FOM n la carpeta de formularios.  Este es el formulario que DAC utilizará 
una vez aprobada.  Un respaldo de su formulario original DAC.FOM se ha copiado a 
la carpeta “Workflow Designer Original Forms” en el directorio de formularios.  Se 
efectuarán los cambios de forma permanente a su formulario original ya que se 
utiliza en todo el proceso de configuración de formulario como una plantilla.  Si 
se realizan cambios en esta plantilla, tendrá que ejecutar el flujo de trabajo para 
ver los cambios en los formularios. 

 

30. Se puede guardar el flujo de trabajo yendo a File>Save pero no es necesario.  Ahora 
puede cerrar el Workflow Designer.  

 
31. La aplicación Spooler debe iniciarse ahora haciendo click en Start> Programs> 

Reform…Spooler.  Una vez abierto, pulse el botón Inicio.  Ahora debería decir Iniciar 
en la esquina inferior izquierda. 

a. Si ya estaba ejecutándose, tendrá que detener y reiniciar para que 
reconozca los nuevos formularios que fueron creadas por el Asistente. 

 
32. Navegue a su directorio \Reform\Backups\. Seleccionar el archivo DAC.out, haga 

click derecho, y seleccione Copy 
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33. Navegue a su directorio \Reform\Spooler\. Haga click derecho  sobre el fondo 
blanco de la ventana y seleccione Paste. (Pegar el secuencia de datos para esta 
carpeta simula la impresión desde Windows, AS400, Unix, etc.). 

 

 
 

a. Cuando la aplicación Spooler comienza a procesar el archivo, se dará 
cuenta de que el nombre de archivo cambia a algo parecido a la imagen 
de abajo. 

 
34. Después de que el documento es procesado por el Spooler, paso siguiente es 

establecer permisos en la interfaz DAC que permita moderar el documento que 
envió al usuario ‘demo’.  

35. Abrir DAC abriendo una ventana de Internet Explorer y desplazarse a 
http://localhost/DAC en el Reform Server.  

a. Si le solicita las credenciales de inicio de sesión, introduzca la 
información de cuenta con la que usted está conectado actualmente en 
Windows.  

36. Haga click en Login. 

 

http://localhost/DAC
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37. Ahora, puede iniciar sesión fuera del panel de administración, haga clic en el botón 

 situado en la esquina superior derecha de la página Web. 

 

Nota: Este inicio de sesión y Cierre de SesiónFii es necesario para ingresar su nombre al 
sistema. Ahora pueden configurar los permisos para su nombre de usuario. 

 

38. Ahora, para iniciar una sesión como administrador del sistema DAC, haga click en el 
vinculo “Logging On As an Administrator?” para mostrar el cuadro de diálogo de 
inicio de sesión en la parte inferior de la pantalla. Escriba estas credenciales 
administrativas: 

 Nombre de Usuario: admin 

 Contraseña: password 

 

 

39. Presione Login. Una vez que haya iniciado la sesión, haga click en la pestaña 
Administrator Permissions. 

 

 
 

40. En esta pestaña, puede establecer permisos para los distintos usuarios de DAC. Los 
permisos son específicos para cada tipo de documento. Pueden ser creados 
muchos tipos de documentos como usted desee en la pestaña Document Types en 
DAC, pero para nuestro ejemplo utilizaremos sólo aquella que hemos creado 
anteriormente en el tutorial, que se llama CCStatement. Seleccione la entrada 
CCStatement en la lista tipo de documento. 
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41. Ahora, tenemos que asignar al usuario que tendrá permisos para aprobar o 
denegar archivos publicado en este tipo de documento. Haga click en el nombre de 
usuario actual en el cuadro de lista de la izquierda y, a continuación, mover el 
nombre a la sección de administradores de documento haciendo click en el botón 
Add.  

 
42. Ahora necesita tener un nivel administrativo. Es en este panel donde niveles de 

jerárquica se pueden configurar los administradores, pero para nuestro ejemplo 
simple, sólo tenemos una sola persona. Después de haber movido su nombre de 
usuario a la lista de Document Admins, haga click en su nombre en la lista para 
seleccionarlo, y, a continuación, aumente el nivel de administración a 1. A 
continuación, haga click en el botón Save Settings. 
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43. A continuación, seleccione su nombre de usuario y haga click en el botón de Edit 
User Control para abrir la ventana User Control Permissions. 

 
44. Marque la casilla junto a la del nombre de usuario “Demo”. Haga click en Save 

Settings para guardar su configuración de permisos. A continuación, cierre la 
ventana User Control Permissions. Después, haga click en Save Settings en el  
Administrator Permissions. 

 
La configuración que acaba de terminar colocará su nombre de usuario en el 
control de todos los documentos de tipo “CCStatement” que se presentan por el 
usuario ‘Demo’. 

 

45. Ahora, puede iniciar sesión fuera del panel de administración, haga click en el 

botón  situado en la esquina superior derecha del panel de 
administración.  

 

Cuando vuelva a la pantalla principal de inicio de sesión, haga clic en Login.  

 

 
 

46. Ahora se puede ver la interfaz principal del DAC. En el medio tiene una lista de 
todos los documentos que usted tiene el control autoritario. Como puede ver, 
tiene varias opciones que permiten controlar el documento que se presentó.  
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Nota: Aprobar el documento se envía a la impresora seleccionada anteriormente 
durante la configuración. 

 

Las opciones disponibles permiten: 

 Ver una historia de aprobaciones y visitas del documento 

 Aprobar el documento, que enviará el documento a los administradores de los 
próximos para su aprobación. Una vez que todos los administradores configurados 
hayan aprobado el documento, se enviará a Reform para ser procesados. 

  Negar el documento que se enviará el documento a Reform para procesar. 

 

 
 

Una vez que el documento ha sido aprobado por el administrador del nivel más alto, 
DAC automáticamente hace copias de los archivos y les coloca en el directorio de 
Spooler. Cuando esto se hace, el final del nombre de archive  tendrá el texto-
Aprobado anexado a él para que se aplique el formato correcto para el archivo.  El 
archivo generado para esta muestra se llama  “CCStatement-Approved”. 

 

Una vez que se genera este archivo, puede configurarse para impresión, correo 
electrónico, archivos, etc., todo mediante la modificación del formulario –Aprobado o 
configurarlo mediante el Workflow Designer. 

 

Usando y Configurando DAC 
Vision General DAC 
En general, DAC es una jerarquía de los usuarios y administradores. El número de 
usuarios, los administradores y los niveles en el sistema es infinito, y el número de 
posibles jerarquías es ilimitado. Puede crearse una jerarquía para cada tipo de 
documento, lo que le permite ser extremadamente personalizable. 
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La figura anterior es sólo un ejemplo de una jerarquía que podría utilizarse. Esto 
demuestra que es posible mantener diferentes departamentos de visualización de 
documentos de los demás. También es posible que alguno de los administradores de 
nivel 1 se les permitiera ver los documentos de cualquier departamento, 
dependiendo de lo que se necesita. En este ejemplo, Usuario 5 es único porque los 
documentos que presenten pueden ser aprobados por el administrador del nivel 1 de 
Departamento B o C. Estas opciones permiten que el sistema sea completamente 
personalizable para las necesidades del usuario. 

 

En este ejemplo, un usuario presentará un documento para ser aprobado. Los 
administradores de nivel 1 para ese usuario, a continuación, tienen varias opciones. 
Podían: aprobar, denegar, o ver el documento. También podrían añadir comentarios 
al documento a fin de comunicarse con el usuario o el administrador que presentó o 
aprobó. Una vez que el Nivel 1 ha sido aprobado, el documento se inserta hasta la 
escalera en el administrador de nivel 2. El administrador nivel 2 puede bien aprobar, 
negar, etc. El documento, a continuación, pasaría al administrador de Nivel 3. Una vez 
que se alcanza la cima de la jerarquía, el documento ha completado los pasos 
necesarios y se procesa en consecuencia. 

 

Conectándose a DAC 
DAC utiliza su nombre de usuario de Windows para iniciar la sesión en el sistema. 
Todo lo que los usuarios deben hacer para iniciar la sesión es haga click en “Login”. Si 
es un administrador del sistema y necesita editar los permisos, haciendo click en el 
“Logging on as Administrator?” mostrará la mitad inferior de la pantalla de inicio de 
sesión. Esta porción permite introducir el nombre de usuario de administrador del 
sistema y la contraseña. 
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El área bordeada de rojo que se muestra en la parte inferior aparecerá sólo cuando 
un usuario hace click en el enlace “Logging on as Administrator?”. 

 

   

Agregando Usuarios y tipos de Documentos  
La primera vez que un nuevo usuario inicia sesión en el sistema, su nombre se añade 
a la lista de nombres almacenados. Por ejemplo, si un administrador del sistema es 
necesario darle privilegios de administrador de nivel 1 a Joe, Joe tendría que ingresar 
para tener su nombre agregado a la lista. A continuación, el administrador del sistema 
pueda darle los permisos necesarios. 

Tipos de documento trabajan de la misma manera. Para tener un tipo de documento 
agregado a la lista, el usuario simplemente tiene que enviar un archivo de ese tipo a 
DAC. DAC, a continuación, lo agregará a la lista de tipos de documentos disponibles, 
permitiendo que una nueva jerarquía se cree para ese tipo. 

   

Estableciendo Administradores DAC  
Para establecer permisos para los usuarios y administradores, el administrador del 
sistema debe iniciar sesión como se describe en la sección anterior. Una vez iniciada 
la sesión, puede hacer clic en la pestaña “DAC Permissions” para acceder a las 
opciones disponibles. A continuación se muestra un ejemplo de lo que debería ver: 
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Se muestra en esta ilustración, puede ver los usuarios disponibles, administradores de 
documento, seleccione Authority Document, y varios otros botones. Lo primero que 
hay que hacer para crear la jerarquía es seleccionar el tipo de documento correcto. La 
que se muestra aquí es “Sales Receipt”.  

 

A continuación, seleccionando los usuarios en el lado izquierdo, y haciendo click en el 
botón ADD el usuario seleccionado aparecerá en la lista de administradores de 
documento con un 0 junto a su nombre. Mediante los botones de aumento y 
disminución, se puede cambiar el nivel del usuario seleccionado hasta que sea 
correcta. El administrador del nivel más bajo es 1.  

 

 
 

El nivel actual del usuario se muestra  junto a su nombre de usuario en Document 
Admins (Ejemplo: Gary (2) - Gary es un Administrador Nivel 2). Este proceso se repite 
hasta que todos los administradores estén en el nivel correcto. Una vez finalizado el 
proceso, haga click en  “Save Settings”. En este momento en este ejemplo, tenemos 
los niveles de estructura similar al siguiente: 
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Estableciendo Permisos a Administradores  
Ahora que los niveles se han creado correctamente, debemos dar a los 
administradores permiso para aprobar los documentos específicos del usuario. De 
esta forma, podemos romper la jerarquía en departamentos o grupos de usuarios. 
Haciendo click en el botón “Edit User Control” que se ha mostrado anteriormente, 
puede editar la configuración del usuario seleccionado. Aparecerá la siguiente 
ventana: 

 

 
 

Como se ve, estamos accediendo a los permisos del usuario Gary para el tipo de 
documento “Sales Receipt”. También hay una lista de usuarios disponibles que puede 
darse los derechos para aprobar documentos para Gary. Aquí mostramos que él 
pueda aprobar documentos para Mike y Ruth ya que Gary es un administrador de 
nivel 2 y Mike/Ruth son administradores de nivel 1.  También puede aprobar 
documentos de Chl, John y Matt una vez que son aprobadas por Mike o Ruth. Una vez 
completa la configuración deseada, haga click en “Save Settings”. Este proceso se 
repite para Mike y Ruth para que sean capaces de aprobar los documentos para el 
resto de los usuarios (Chl, John y Matt). Para nuestro ejemplo, vamos a dar permiso a 
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Ruth para aprobar documentos de Matt y Chl. Además, Mike se dará permiso para 
aprobar documentos de John. Nuestro ejemplo jerarquía final se muestra a 
continuación: 

 
   

La interfaz de Usuario DAC  
Para acceder a la interfaz de DAC, el usuario debe iniciar sesión en la página Web de 
DAC. Una vez iniciada la sesión, será necesario hacer click en el vínculo “Document 
Authority Control” en la esquina superior derecha. Entonces debería ver una pantalla 
similar a la que se muestra a continuación. 

 

 
 

En el lado izquierdo, esta cifra muestra tres recibos de ventas enviados por el usuario 
"marci", en la fecha 28/05/2008. También muestra la descripción como "información 
de ventas para orden ######". En la esquina superior izquierda, puede ver el usuario 
registrado es "chrisl2007". Si el usuario mueve el mouse del mouse sobre el texto en 
azul  “Sales Receipts from marci…” una pequeña ventana aparecerá sobre el texto con 
una captura de la imagen TIF que fue enviada para que puedan ver exactamente lo 
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que parece. El lado derecho muestra las opciones disponibles para el usuario 
conectado.  

Este usuario tiene privilegios administrativos completos con los documentos 
presentados por "marci". Aprobarlo sería enviar el archivo al administrador del 
siguiente nivel, mientras negarlo sería mandarlo de regreso a la persona que lo 
aprobó y presento por debajo del usuario actual.  
 

 
   

En la parte inferior izquierda de la pantalla del usuario en el DAC/Document Monitor, 
hay dos opciones que permiten cambiar la configuración la forma en la que Document 
Monitor y DAC se ejecutan. El primer enlace establecerá que se abre la página hasta 
después de que un usuario inicia una sesión, DAC, o Document Monitor. El segundo 
enlace establecerá a Document Monitor como página de inicio del navegador. 
 

Internet Explorer y  Ventanas Emergentes  
Al agregar comentarios a un documento, Internet Explorer puede decir que se han 
bloqueado las ventanas emergentes. 

 
 

Para solucionar este problema, haga click en la barra resaltada y vaya a Pop-up 
Blocked> Always Allow Pop-ups from This Site… 

Después de actualizar la página, podrá agregar comentarios. 

 

 

Reform - Secuencia de Comandos DAC Send To  
La secuencia de comandos de DAC.fbs puede encontrarse en la carpeta 
"SendToScripts". Cuando se ejecuta esta secuencia de comandos, primero toma toda la 
información correspondiente del archivo, tales como: nombre, fecha, hora, adjunto, 
nombre del remitente, Spooler, descripción, nombre de archive de imagen TIF y 
directorio. DAC.fbs utiliza esta información para rellenar la base de datos con la 
información que se utilizará con DAC. La secuencia de comandos también se utiliza 
para mover el archivo de Spooler y la imagen TIF en el directorio 
“FSMonitor\DACJobs\” para que DAC pueda procesarlos. 
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Reform – Formularios DAC 
Cuando el documento se envía al sistema, se abre el formulario correspondiente. Este 
formulario sólo tendría la imagen presentada y utilizaría DAC como “Transport Type” 
en las opciones de configuración pagina, tal como se muestra a continuación. 
Estableciendo DAC como el tipo de transporte, esto permite que la Secuencia de 
comandos DAC.fbs que se ejecute una vez finalizada la página de procesamiento. 

 

La secuencia de comandos a continuación, moverá los archivos en el directorio 
correcto para ser procesados, así como agregar la información a la base de datos. 
También hay tres campos que son necesarios para ser utilizados en el formulario: 
LoginName, DACDescription, y DACFormType. El Nombre de Usuario es el nombre del 
usuario que envía el archivo DAC. La DACDescription es un breve resumen de lo que es 
el archivo. DACFormType dice a DAC qué tipo de documento es el archivo, para que 
puedan determinar los administradores y los permisos para el archivo en función del 
tipo. 

 

 

Visión General DAC  

Introducción  
Para iniciar el proceso, un usuario debe presentar un documento en el sistema que 
necesitaría autorización. Para esta explicación, vamos a escanear un formulario que 
alguien podría presentar si regresaban de un viaje de negocios y necesita ser 
reembolsados. Porque es un precio bastante grande para la empresa a pagar, debe ser 
autorizada antes de que el departamento de Finanzas podrá reembolsar el dinero 
invertido en el vuelo, hotel, comidas, etc. 
 

DAC Árbol de Aprobación / Negación  
En este punto en el ejemplo, tomaremos el lugar de Matt en el árbol. Para demostrar 
cómo pueden ser aprobados y negó hasta que se procesan documentos. Considere la 
figura que se muestra a continuación. (En página 25). 
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El usuario que presentó el documento actual es Matt. Ahora, DAC envía el documento 
a Ruth. Ella puede aprobar, denegar o añadir un comentario. Si no están seguros de 
qué los recibos que Matt está tratando de reembolsar, pueden utilizar los comentarios 
para comunicarse hasta que todo el mundo entiende lo que es ser aprobado. Una vez 
que Ruth aprueba el documento, Gary tiene las mismas opciones que antes. Deja decir 
por alguna razón, después de que Gary se comunica con Ruth mediante el sistema de 
comentarios, y siente que los recibos son razonables, hace click en Deny. Esto enviará 
el documento a Ruth. Ruth luego se comunicaría Matt, donde haría los cambios 
necesarios, y luego presentarlos para su aprobación.  Satisfechos con los cambios, Ruth 
aprueba y, a continuación, Gary aprueba el documento. Aquí, hemos alcanzado el 
punto más alto en la jerarquía, por lo que el documento se envía para ser procesado. 

   

Procesando el Documento 
Una vez que el documento ha sido aprobado por el administrador del nivel más alto, 
DAC automáticamente realiza una copia de los archivos y las coloca en el directorio 
Spooler. Cuando lo hace, al final del nombre del archivo, agregará el texto “-Approved” 
para que el formato correcto se aplique en el archivo. DAC también mantiene una 
copia del archivo en el directorio "FSMonitor\DACJobs" para los registros de la 
empresa. 

 
 

El Spooler reconocerá inmediatamente el archivo y aplica los formularios apropiados. 
En este punto, el documento puede ser enviado por email, fax, archivado, impreso, 
etc. 
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Mantenimiento 
Hay ciertos directorios y tablas SQL que deben controlarse para crecimiento, junto con 
el plugin Email para Reform 12.  Cada vez que un sistema procesa más y más trabajos, 
el tamaño de estos directorios y tablas SQL puede crecer muy rápidamente. En general 
el rendimiento del sistema puede verse afectado por la gran cantidad de espacio que 
pueden ocupar los archivos.  Además, existe un límite de base de datos de 4 GB si 
utiliza Microsoft SQL Server Express 2005 suministrado con la instalación. Entradas 
obsoletas archivos/base de datos se deben eliminar de acuerdo a sus necesidades y 
especificaciones de retención de archivos. Se recomienda monitorear el crecimiento de 
los siguientes directorios y tablas SQL. 

 

Directorios: 

C:\Program Files\Reform…\Backups 

C:\Program Files\Reform…\Spooler\ImageQueue 

C:\Program Files\Reform…\Plugins\DAC\Website\DACJobs\ 

C:\Program Files\Reform…\Plugins\DAC\Website\DACJobs\ImageQueue 

 

Tablas SQL: 

DAC-Admins 

DAC-Comments 

DAC-DocTypes 

DAC-Documents 

DAC-History 

DAC-Permissions 

DAC-Versions 

 

Instalando/Configurando Internet Information Services (IIS) 
2003 
Internet Information Services es necesario para operar el Document Authority Control. 
Esta sección le guiará a través de cómo instalar IIS 2003, así como la configuración de 
la instalación para garantizar el funcionamiento correcto de DAC. Esta instalación 
requiere Windows 2003 Service Pack 2 CD/DVD. 

 
Ir a Start>Control Panel>Add/Remove Programs. 
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En Add/Remove Programs, haga click en el botón Add/Remove Windows Components. 
 

 
 

Verá una lista de componentes de Windows que puede instalar. Para buscar Internet 
Information Services, haga click en Application Server, luego haga click en el botón 
Details. 
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Otra ventana aparecerá con varios componentes, que puede instalar. Tenemos que 
instalar Internet Information Services, así que marque la entrada para IIS. Observará 
que se seleccionará la red habilitar acceso COM +, esto es normal. Haga click en el botón 
OK. 

 

 
 

Haga click en el botón Next para comenzar el proceso de instalación. 
 

 
 

Ahora comenzará la instalación. Después de algunos segundos, aparecerá una ventana 
que le pedirá que elija la ubicación de los archivos en el CD/DVD. Haga click en el botón 
Examinar para abrir un diálogo de abrir el archivo. 
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En el Service Pack 2 DVD, puede encontrarse el archivo que necesita para localizar en: 
 

D:\English\WindowsServer2003R2withSP2\Enterprise\32bit\i386\ CONVLOG.EX_ 
 

 
 

Después de seleccionar el archivo, haga click en OK para cerrar el cuadro de diálogo 
Abrir archivo y, a continuación, haga click en Retry en el mensaje de Copy Error. La 
instalación se reanudará. 

 
Una vez finalizada la instalación, puede cerrar de agregar o quitar programas. En este 
punto, debe instalar DAC y, a continuación, volver a esta sección después de configurar  
Internet Information Services para permitir a DAC funcionar correctamente. 
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Después de haber instalado el Document Authority Control: 
Vamos a cambiar algunas configuraciones de IIS que permitirán a DAC ejecutarse en un 
entorno de Windows 2003. 
 
Ir a Start>Administrative Tools>Internet Information Services (IIS). 
 

 
 

Amplíe la vista de árbol en el panel izquierdo bajo SystemName>Application Pools.  
Haga click derecho en DefaultAppPool y seleccione Properties. 

 

 
 

En la pestaña Identity tab, seleccione la opción Predefined, y escoja Local System en el 
menú desplegable. Haga click en  OK para guardar los cambios. 
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En el panel izquierdo en el administrador de IIS, haga click en Web Service Extensions. 
Tenemos que permitir que las siguientes extensiones:  

 All Unknown ISAPI Extensions 

 Active Server Pages 

 ASP.NET v2.0.50727 

 Server Side Includes 
 

 
 

Haga click derecho en cada una de estas entradas y haga click en Allow. Si aparece una 
advertencia, ignorarla y haga click en Yes.  
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Repita estos pasos hasta que las 4 extensiones mencionadas tengan en estado Allowed, 
como se muestra a continuación. 

 
Lo último que tenemos que hacer es comprobar que la versión correcta de ASP.NET está 
siendo utilizado. 
 
En el panel izquierdo, expanda los vista de árbol Web Sites>Default Web Site.  
Haga click derecho en DAC y seleccione Properties. 
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En la ventana de propiedades, vaya a la pestaña ASP.NET y cambie la versión ASP.NET 
a 2.0.*. Haga click en OK para cerrar la ventana de propiedades, y ahora puede cerrar 
el administrador de IIS. 

 

 
 

Para comprobar que los Servicios Internet Information están configurados 
correctamente, intente abrir una ventana de Internet Explorer y abra DAC navegando a 
http://localhost/DAC en el Servidor Reform. 

 
Si se presentan con la pantalla de inicio de sesión principal, han configurado 
correctamente IIS para que funcione correctamente el Document Authority Control. 

 

Configurando Internet Information Services (IIS) 7 
Esta sección le guiará a través de configuración DAC/DeviceViewer con IIS 7 en un 
entorno de Windows Server 2008. 

 
1. Ir a Start>Administrative Tools>Internet Information Services (IIS) Manager. 
2. Haga click en Application Pools en el panel Connections. 
 

 
 

3. En la lista Application , haga click derecho en DAC / DeviceViewer y haga click en 
Advanced Settings. 

http://localhost/DAC
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4. Seleccione las siguientes propiedades: 

a. .NET Framework Version = v2.0 
b. Enable 32-Bit Applications = True 
c. Managed Pipeline Mode = Classic 
d. Identity = Local System 

5. Haga click en OK para guardar los cambios. 
6. En el panel Connections, expanda Sites, expanda Default Web Site, y seleccione 
DAC/DeviceViewer. 

 

 
 

7. En el panel del centro, haga click derecho en .NET Users y haga click en Basic 
Settings. 
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8. Haga click en Connect As… Seleccione la opción Application User (pass-through 
authentication) y haga click en OK. 

9. Haga click en OK en la ventana Edit Application para guardar los cambios y cerrar 
la ventana. 

10. Haga doble click en Authentication en el panel central. 

 
11. Activar ASP .NET Impersonation y Windows Authentication. Para activar una 
opción, haga click en el elemento de la lista y haga clic en Enable. 

12. Haga click en DAC/DeviceViewer en el panel Connections para mostrar las 
categorías de configuración en el panel central. Haga doble click en HTTP Response 
Headers. 

 
Haga click en Set Common Headers en el panel Actions. 

 

 
 

13. Revisar la opción Expire Web content, y establecerla en 30 days. Haga click en 
OK para guardar los cambios. 
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14. En el panel izquierdo, seleccionar su computadora. 
 

 
 

15. Doble click en ISAPI and CGI Restrictions. 

 
16. Permitir los siguientes elementos en la lista: 

 Active Server Pages 
 ASP.NET v2.0.50727 
 

 
 

17. Ha terminado de configurar Internet Information Services 7. Microsoft.NET 
Framework 3.5 SP1 puede ser requerido a instalarse en el servidor. 

 
 
 

Solución de Problemas 
Q: Recibo el Error “Failed to access IIS metabase” en el Device Viewer y/o DAC. 

A: Si este error se recibe en DAC, necesita realizar una reparación de la.NET 
Framework. 

1. Ir a Start>Control Panel. 
2. Abrir Add/Remove Programs. 
3. Buscar lista de programas por Microsoft .NET Framework 2.0. 
4. Seleccione la entrada y haga click en el botón Change. 
5. Seleccionar Repair y siga paso a paso a través de los mensajes.  
6. Una vez completada la reparación, vaya a Start>Run y escriba iisreset. Presione 

OK. Después de reiniciar IIS, intente navegar a http://localhost/DAC. No debe 
recibir más el error 

 

Q: No se puede abrir TIFF grandes (más de 30/40 páginas) desde el sitio Web DAC. 

http://localhost/DAC
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Error: The Windows Photo Viewer da el siguiente error después de abrir algunas 
páginas: Windows Photo Viewer no puede abrir la imagen porque Photo Viewer no 
admite este formato de archivo, o no tiene las actualizaciones más recientes para el 
Photo Viewer. 

 

o 

 

Error: Abrir el formato tiff con una estación de trabajo Windows 7, aparece el 
siguiente error después de ver algunas de las páginas: Windows Photo Viewer no 
puede abrir esta imagen porque el archivo parece estar dañado, corrupto, o es 
demasiado grande. 

 

A: Utilizar un visor diferente tiff, no estación de trabajo Windows 7  
  

 


